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Overview
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Figure 1

The GWT Composite Builder product simplifies the development of GWT Composite Widgets.
When developing a custom widget a Composite is usually preferred to extending another widget
because a Composite controls exposing its wrapped widget's methods and properties.

The Composite Builder was developed using Eclipse 3.4 and the Google Web Toolkit (GWT 1.6.4).
The Composite Builder runs in a web browser (no Plugins) with JavaScript enabled.

The Composite Builder has been tested on IE 7.0 and Firefox 3.0.9.

The ‘COMPQOSITE’ region (surrounded by the dashed blue border) contains the visual representation

of the Composite widget being created.

The Composite may be exported/imported to/from XML.
The Composite may also be exported to Java, then copied and pasted into the user’s favourite IDE,

where business logic and event handling may be included.

Import of Java code is not supported.

If you require a product that supports bi-directional code generation then you might want to check out

GWT Designer http://www.instantiations.com/gwtdesigner/
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Tool Structure
The Composite Builder has the following regions, shown in Figure 1 above.

A.1 Heading
The heading section shows the Composite’s Java package and class name.
You provide this information when the Composite Builder is started, or via the File Properties menu.

A.2 Menu
The Menu section contains:
A.2.1 File
Export Java — displays a TextArea containing the Composite’s Java code
(Use copy/paste to save it in a local file)

Export XML — displays a TextArea containing the Composite as XML
(Use copy/paste to save it in a local file)

Import XML — displays a TextArea to paste ‘Exported XML’ to rebuild the Composite.
Properties — provide the Composite’s Java package and class name

A.2.2 Edit
Apply CSS — applies the CSS, entered in the CSS section to the COMPOSITE

Reset CSS — removes the CSS, entered in the CSS section from the COMPOSITE

A.2.3 View
Show in DialogBox — displays the COMPOSITE wrapped in a DialogBox
Show in DecoratedPopupPanel — displays the COMPOSITE wrapped in a
DecoratedPopupPanel
Show in PopupPanel — displays the COMPOSITE wrapped in a PopupPanel

A.2.4 Tools
Show HTML Outline — displays a TextArea containing an outline of the Browser's DOM
for the COMPOSITE. Useful when defining CSS selectors.

Show HTML Detail — displays a TextArea containing the InnerHTML for the
COMPOSITE. Useful when defining CSS selectors and to see the DOM detail.

Clear Ul — removes all LabWidgets and CSS from the COMPOSITE.

A.2.5 Help
User’s Guide — This document.

About — summary information about the Composite Builder.
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B - GWT Widgets

The GWT Widgets section contains the widgets that may be included in the Composite. Scroll
through the list and select the type of widget that you wish to create. Clicking on a widget displays a
sample name, for the LabWidget, that you may modify. Details for each GWT Widget is described
later in this document.

C - LabWidget

The LabWidget section controls the creation and removal of the Composite’s widgets.
A LabWidget (Laboratory Widget) wraps a GWT widget and stores its properties.

The LabWidget section contains:

A TextBox for entering the widget’s Java coded name.
The name you assign must be unique for all your LabWidgets in the Composite.

A ‘Create’ button to create the LabWidget and add it to the Ul Tree.
Radio Buttons ‘Add Child’ and ‘Insert’ control where widgets are placed in the Ul Tree.

Add Child — the LabWidget is added as a child to the selected item in the Ul Tree.
If the Ul Tree is empty then the widget becomes the Composite’s main, or Root widget.

Insert — the LabWidget is inserted before the item selected in the Ul Tree.

To add a LabWidget to the Ul Tree:
. Assign a unique name to the LabWidget
. Select the correct radio button (Add Child, or Insert)
. Select its target item in the Ul Tree
. Click Create or press Enter

Splitter

Drag the Splitter to resize the height of the Ul Tree, Property Editor, and CSS sections in the bottom
of the VerticalSplitPanel.

Page 9



GWT Composite Builder

D - Ul Tree

The Ul Tree section is used to maintain the Composite widget’s parent / child relationships.
Adding a widget to the Ul Tree automatically displays it in the COMPOSITE.

LabWidgets are added to the Ul Tree as described in section 3 above.
LabWidgets (and their children) may be rearranged within the Ul Tree.
To change the Ul Tree structure:
. Select the correct radio button (Add Child, or Insert)
. Press ‘Shift’ and click on the LabWidget to cut/move. (It will become highlighted)
. Press ‘Shift’ and click on the paste/target LabWidget to move the highlighted Widget and its
children to the target and automatically display the changes in the COMPOSITE.

Dragging a LabWidget to the Trash can (in section 3) removes it and its children from the Ul Tree and
from the COMPOSITE.

E - Property Editor

The Property Editor section is used to maintain the Ul Tree LabWidget's properties.
Selecting a widget in the Ul Tree displays its properties in the Property Editor and any changes are
automatically reflected in the COMPQOSITE.

The Properties are grouped into four sections. Press a group’s arrow to show/hide its properties.
General — common to all widgets, excluding the Style properties

Style — CSS styling properties

Specific — properties that are specific to the type of widget

Cell — properties when a widget is contained in a FlexTable, via a FlexRow

F - CSS
The CSS section is used to enter CSS rules for the Composite.
To add or maintain CSS:
. If required, assign the CSS style to a widget using the Property Editor
. Enter the CSS selector and its properties in the CSS section
For example, to add a border to the style ‘mystyle’
.mystyle { border: 1px solid blue; }
Select ‘Apply CSS’, from the ‘Edit’ menu, to apply the rules to the COMPOSITE.

Use copy/paste to save the CSS rules in your application’s css file.
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COMPOSITE

The COMPOSITE section shows the visual representation of the Composite.
The appearance of the Composite is automatically changed when

its structure is maintained in the Ul Tree

its widget’s properties are changed in the Property Editor
c) its CSS rules are applied or removed via the Edit menu

Comments / Feedback

Please send your feedback to me at  jimcampsw@gmail.com
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Getting Started

This section describes the steps for creating the ‘Contact Information’ Composite,
shown below.

. Decide on the type of GWT widget to use as the wrapper for the Composite
. Design the layout and structure of the contained widgets

. Build the Composite

. Assign the CSS Styles

. Export XML and save in local file

. Export Java and copy to favourite IDE

. Modify Java code to implement required interfaces and business logic

. Test

o~NOoOO OO =

Figure 2

Personal Private

-Personal Information

My Name: | |

Gender: &~ Male " Female

Birthday:

Brazil N

Ve IN’ - rommrr——

New | Update ‘

1. Decide on the GWT widget to use as the wrapper for the Composite
A DecoratedTabPanel widget has been chosen as the main widget for our Composite.

2. Design the layout and structure of the contained widgets
The layout and structure for the ‘Personal’ information tab is shown above
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3. Build steps

For this example, we will first add all of the components to the Ul Tree then modify their properties in
the Property Editor.

During the Build steps we will create the LabWidgets and assign their Text values through the
Property Editor. In the next section ‘CSS steps’ we focus on their visual appearance.

3.1 Create LabWidgets

3.1.1 Select ‘DecoratedTabPanel’ in the list of GWT Widgets

Enter its name (For example, myDecoratedTabPanel) in the LabWidget TextBox

Ensure that the ‘Add Child’ radio button is selected

Click the ‘Create’ button or press ‘Enter’ to add the LabWidget into the Ul Tree

The ‘myDecoratedTabPanel’ should now be selected in the Ul Tree and in the Property Editor.
The COMPOSITE section will become visible once a child widget is added.

3.1.2 Select ‘CaptionPanel’ in the list of GWT Widgets

Enter its name (For example, personalCaptionPanel)

Click the ‘Create’ button or press ‘Enter’ to add the ‘personalCaptionPanel’ as a child of
‘myDecoratedTabPanel’ in the Ul Tree

The COMPOSITE section should now display the ‘personalCaptionPanel’ as the first tab

3.1.3 Select ‘CaptionPanel’ in the list of GWT Widgets, if not already selected
Enter its name (For example, otherCaptionPanel)

Click the ‘Create’ button or press ‘Enter’ to add the ‘otherCaptionPanel’ as a child of
‘myDecoratedTabPanel’ in the Ul Tree

The COMPOSITE section should now display the ‘otherCaptionPanel’ as the second tab

3.1.4 Add widgets to the ‘personalCaptionPanel’ Select ‘personalCaptionPanel’ in the Ul Tree
(The Property Editor shows the selected widget in its heading)

To layout the widgets in the personalCaptionPanel we will use a FlexTable

Select ‘FlexTable’ in the list of GWT Widgets

Enter its name (For example, personalFlexTable)

Click the ‘Create’ button or press ‘Enter’ to add the ‘personalFlexTable’ as a child of
‘personalCaptionPanel’ in the Ul Tree.

3.1.5 Add widgets to the ‘personalFlexTable’ Select ‘personalFlexTable’ in the Ul Tree

To simplify construction, the Composite Builder uses a ‘FlexRow’ to hold a row of widgets in a
FlexTable. A ‘FlexRow’ is only used internally within the Composite Builder.

Select ‘FlexRow’ in the list of GWT Widgets

Enter its name (For example, nameFlexRow)

Click the ‘Create’ button or press ‘Enter’ to add the ‘nameFlexRow’ as a child of ‘personalFlexTable’
in the Ul Tree
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3.1.6 Similarily, add FlexRows for ‘genderFlexRow’, ‘birthdayFlexRow’, ‘locationFlexRow’, and
‘buttonFlexRow’ as children of ‘personalFlexTable’ in the Ul Tree.

3.1.7 In a similar manner add widgets to the FlexRows

To ‘nameFlexRow’ add a Label ‘namelLabel’, TextBox ‘firstNameTextBox’ and ‘lastNameTextBox’
To ‘genderFlexRow’ add a Label ‘genderLabel’, and RadioButtons ‘genderMaleRadioButton’ and
‘genderFemaleRadioButton’

To ‘birthdayFlexRow’ add a Label ‘birthdayLabel’ and a DateBox ‘birthdayDateBox’

To ‘locationFlexRow’ add a Label ‘locationLabel’ and a ListBox ‘locationListBox’

To ‘buttonFlexRow’ add Button ‘newButton’ and ‘updateButton’

Click on the first tab in the COMPOSITE to show its widgets.

3.2 Modify LabWidgets Properties

Let’s modify the COMPOSITE by changing some of its properties in the Property Editor.
If you need to rearrange widgets in the Ul Tree refer to section D — Ul Tree, above.

3.2.1 Changes to ‘personalCaptionPanel’

Select the ‘personalCaptionPanel’ widget in the Ul Tree

Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘Personal’ in the ‘TabText’ field

Enter ‘Personal Information’ in the ‘CaptionText’ field

3.2.2 Changes to ‘personalFlexTable’

Select the ‘personalFlexTable’ widget in the Ul Tree

Expand the Property Editor’s ‘General’ panel by clicking on its heading
Enter ‘100%’ in the ‘Width’ field

Expand the Property Editor’s ‘Cell’ panel by clicking on its heading
Enter ‘5’ in the ‘CellPadding’ field

3.2.3 Changes to the widgets in ‘hameFlexRow’

Select the ‘namelabel’ widget in the Ul Tree

Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘My Name:’ in the ‘Text’ field
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3.2.4 Changes to the widgets in ‘genderFlexRow’

Select the ‘genderLabel’ widget in the Ul Tree

Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘Gender:’ in the ‘Text’ field

3.2.5 Select the ‘genderMaleRadioButton’ widget in the Ul Tree
Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘Male’ in the ‘Text’ field

3.2.6 Select the ‘genderFemaleRadioButton’ widget in the Ul Tree
Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘Female’ in the ‘Text’ field

3.2.7 Changes to the widgets in ‘birthdayFlexRow’

Select the ‘birthdayLabel’ widget in the Ul Tree

Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘Birthday:’ in the “Text’ field

3.2.8 Changes to the widgets in ‘locationFlexRow’

Select the ‘locationLabel’ widget in the Ul Tree

Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘I live in:" in the ‘Text’ field

3.2.9 Select the ‘locationListBox’ widget in the Ul Tree
Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘Brazil, Canada, United States’ in the ‘Addltem’ field

3.2.10 Changes to the widgets in ‘buttonFlexRow’

Select the ‘newButton’ widget in the Ul Tree

Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘New’ in the ‘Text’ field

Expand the Property Editor’s ‘Cell’ panel by clicking on its heading
Select ‘ALIGN_RIGHT’ from the ‘CellHorizontalAlignment’ dropdown

3.2.11 Select the ‘updateButton’ widget in the Ul Tree
Expand the Property Editor’s ‘Specific’ panel by clicking on its heading
Enter ‘Update’ in the ‘Text’ field

Changes to the second Tab (otherCaptionPanel) are left as an exercise for the reader.
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4. CSS steps

4.1 Changes to ‘myDecoratedTabPanel’

Select the ‘myDecoratedTabPanel’ widget in the Ul Tree

Expand the Property Editor’s ‘Style’ panel by clicking on its heading
Enter ‘contact’ in the ‘StyleName_ADD’ field

(Note: using ‘StyleName_SET’ would replace the default styling)

4.2 Changes to ‘personalFlexTable’

Select the ‘personalFlexTable’ widget in the Ul Tree

Expand the Property Editor’s ‘Style’ panel by clicking on its heading
Enter ‘personalFlex’ in the ‘StyleName_SET’ field

4.3 Select Tools > Show HTML Outline from the menu
Show the outline of the COMPQOSITE and see the CSS class names that you assigned

4.4 Enter the following CSS in the CSS section (the bottom right section of the Composite
Builder)

.contact {
width: 500px;
}

.gwt-TabPanelBottom {
background-color: #D8E8F8;

}

.personalFlex .gwt-Label {
width: 100px;

text-align: right;

}

.personalFlex .gwt-DateBox,
.personalFlex .gwt-TextBox,
.personalFlex .gwt-ListBox {
width: 150px;

}

4.5 Select Edit > Apply CSS from the menu
To apply and see the CSS changes

Your Composite should now look similar to the target ‘Contact Information’ Composite.
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5. Export / Import XML

5.1 select File > Export XML from the menu
A DialogBox will display the COMPOSITE’s XML

5.2 Copy and Paste the XML in a local file
The XML may then be Imported via the File - Import XML menu to make subsequent changes.

5.3 Try to Export then Import the XML for the COMPOSITE

6. Export Java

6.1 select File > Export Java from the menu
A DialogBox will display the COMPOSITE’s Java code.

6.2 Copy and Paste the Java code to your favourite IDE

7. Implement any interfaces and business logic, as required

Import of Java code into the Compositie Builder is not supported.

8. Test

Integrate your modified Java code into your GWT application’s source code.
Copy / paste the CSS rules to your application’s css file.

Test as normal.
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Working with the GWT Composite Builder
The following tips/observations may help you when building your composite.

Disclosure Panel - Specifying the Height of the parent container of Disclosure Panels, causes a gap
between the Disclosure Panels.

During development it may be helpful to add a border to a container to see its boundary.
For example,

add a style ‘outline’ to a component via the Property Editor

enter the CSS below in the CSS section

Apply CSS from the Edit Menu.

Note: Style names entered in the Property Editor have no leading period (.), while style names
entered in the CSS section do have a leading period (.).

.outline {
border: 1px solid grey;

}

The border may not be shown until the container contains at least 1 widget.

Vertical placement of components may be achieved by using a FlowPanel and specifying a width of
100% for its components, as an alternative to using a Vertical Panel.

Setting the height of a VerticalPanel may cause space between vertical components to fill the height.

ListBox — set the height property in the Property Editor, to see ListBox items.
To add multiple items to a ListBox enter the items delimited by comma, in the ListBox’s Addltem

property.

To enter multiple suggestions for a SuggestBox enter the suggestions, delimited by comma, in the
SuggestBox’s Suggest property.
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Anchor  The following target names are reserved and have special meanings.

_blank  The user agent should load the designated document in a new, unnamed window.

_self The user agent should load the document in the same frame as the element that refers
to this target.

_parent The user agent should load the document into the immediate FRAMESET parent of the
current frame.
This value is equivalent to _self if the current frame has no parent.

_top The user agent should load the document into the full, original window (thus canceling
all other frames).

For example, entering ‘http://www.google.ca’ and ‘_blank’ in the Property Editor’s ‘Href’, and ‘Target’
properties, respectively will open up a new window for Google.

Only Treeltems may be children of a Tree.

A Menultem (with a Command) or a MenuSeparator may only be added to a MenuBar (or MenuBarV)
Adding a MenuBar (or MenuBarV) to a Menultem adds a submenu.

Two modes are provided to populate a Grid:

a) The default quick mode fills the grid cells with row and column strings (Rn, Cm)
Entering values for RowCount or ColumnCount, via the Property Editor, resizes and
populates the cell contents.

b) The second mode is used to fill a column with widgets.

Adding a widget to a grid fills a column of corresponding widgets.
row 0 — contains the column Headers, as Labels
row 1 — subsequent rows contain widgets of the added type

The Composite Builder restricts the widgets that may be added to a Grid to:

Anchor, Button, CheckBox, DateBox, Hidden, Image, Label, ListBox, PasswordTextBox,
PushButton, RadioButton, SimpleCheckBox, TextArea, TextBox, and ToggleButton.

To add widgets to a FlexTable, first add a FlexRow(s) to the FlexTable then add widgets to the
FlexRow(s).
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The COMPOSITE may be shown in a DialogBox, DecoratedPopupPanel, or PopupPanel via the View
menu. Java is not generated for these Popup Panels, but may be easily added to the Java that is
generated for the COMPOSITE.

For example, the Java to include the Composite named MyComposite, in a DialogBox.

final MyComposite widget = new MyComposite();
final DialogBox popup = new DialogBox(true);  // auto-hide
popup.setText("MyComposite Dialog Heading");

popup.addCloseHandler(new CloseHandler<PopupPanel>() {
public void onClose(CloseEvent<PopupPanel> event) {
// do something
popup.hide();
}
1

popup.setWidget(widget);

popup.show();

To create a Horizontal Ruler, create an HTML widget and set its HTML to  <hr/>

The first LabWidget created becomes the Root of the Ul Tree and it must remain the Root, unless it is
dragged to the trash, which will remove it and all the LabWidgets from the Ul Tree.

If required, you could modify the exported XML to include a new Root then import the modified XML.
(Modifying the XML is beyond the scope of this document)

If the Root widget is not displaying its expected style then you may have overridden its default styling.
Check the Tools > HTML Outline output for the class assigned to the Root widget.

For example,

If the Root widget is a DecoratorPanel and it is not showing a decorated border then check that its
HTML is similar to:

<TABLE class="gwt-DecoratorPanel">

If not then use the Property Editor to set the expected css class names.

If you change the appearance of the Ul Composite directly, rather than through the Property Editor,
then the Export/Import of XML may not be what you expected, as only changes applied via the
Property Editor are included. For example, if you select a RadioButton in the Ul Composite and do
not change the ‘Checked’ property to true in the Property Editor then it would be unselected if you
were to Export / Import XML.
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GWT Widget Detail

The following list contains the GWT Widgets supported by the GWT Composite Builder.
The descriptions are from the GWT API.

Type

Description / CSS

Comment

AbsolutePanel

An absolute panel positions all of its children absolutely,
allowing them to overlap.

Note that this panel will not automatically resize itself to allow
enough room for its absolutely positioned children. It must be
explicitly sized in order to make room for them.

CSS — no default

Anchor A widget that represents a simple <a> element.
.gwt-Anchor { }
Button A standard push-button widget
.gwt-Button { }
CaptionPanel A panel that wraps its contents in a border with a caption that
appears in the upper left corner of the border. This is an
implementation of the fieldset HTML element.
CSS — no default
CheckBox A standard check box widget. This class also serves as a
base class for RadioButton.
.gwt-CheckBox
the outer element
.gwt-CheckBox-disabled
applied when Checkbox is disabled
Composite A type of widget that can wrap another widget, hiding the Not included in the
wrapped widget's methods. When added to a panel, a GWT Widget list.
composite behaves exactly as if the widget it wraps had been | The top widget in the
added. Ul Tree becomes the
main component of the
Composite being
created.
DateBox DateBox with Date picker. Added in GWT 1.6
.gwt-DateBox
default style name
.dateBoxPopup
Applied to the popup around the DatePicker
.dateBoxFormatError
Default style for when the date box has bad input. Applied
by DateBox.DefaultFormat when the text does not represent
a date that can be parsed
DeckPanel A panel that displays all of its child widgets in a 'deck’, where | Not included in the
only one can be visible at a time. TabPanel uses it. GWT Widget list.
Used by its TabPanel
CSS — no default
DecoratedPopupPanel A PopupPanel that wraps its content in a 3x3 grid, which Via View Menu
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Type

Description / CSS

Comment

allows users to add rounded

.gwt-DecoratedPopupPanel { the outside of the popup }

.gwt-DecoratedPopupPanel
around the content }
.gwt-DecoratedPopupPanel
.gwt-DecoratedPopupPanel
element of the cell }
.gwt-DecoratedPopupPanel
center cell }
.gwt-DecoratedPopupPanel
inner element of the cell }
.gwt-DecoratedPopupPanel
cell }
.gwt-DecoratedPopupPanel
element of the cell }
.gwt-DecoratedPopupPanel
left cell }
.gwt-DecoratedPopupPanel
element of the cell }
.gwt-DecoratedPopupPanel
center cell }
.gwt-DecoratedPopupPanel
inner element of the cell }
.gwt-DecoratedPopupPanel
right cell }
.gwt-DecoratedPopupPanel
inner element of the cell }
.gwt-DecoratedPopupPanel
left cell }
.gwt-DecoratedPopupPanel
inner element of the cell }
.gwt-DecoratedPopupPanel
bottom center cell }
.gwt-DecoratedPopupPanel
inner element of the cell }
.gwt-DecoratedPopupPanel
right cell }
.gwt-DecoratedPopupPanel
inner element of the cell }
corners.

.popupContent { the wrapper

.popupTopLeft { the top left cell }
.popupTopLeftinner { the inner

.popupTopCenter { the top
.popupTopCenterlnner { the
.popupTopRight { the top right
.popupTopRightinner { the inner
.popupMiddleLeft { the middle
.popupMiddleLeftinner { the inner
.popupMiddleCenter { the middle
.popupMiddleCenterinner { the
.popupMiddleRight { the middle
.popupMiddleRightinner { the
.popupBottomLeft { the bottom
.popupBottomLeftinner { the
.popupBottomCenter { the
.popupBottomCenterlnner { the
.popupBottomRight { the bottom

.popupBottomRightinner { the
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Type Description / CSS Comment
DecoratedStackPanel A StackPanel that wraps each item in a 2x3 grid (six box),
which allows users to add rounded corners.
.gwt-DecoratedStackPanel { the panel itself }
.gwt-DecoratedStackPanel .gwt-StackPanelltem { unselected
items }
.gwt-DecoratedStackPanel .gwt-StackPanelltem-selected {
selected items }
.gwt-DecoratedStackPanel .gwt-StackPanelContent { the
wrapper around the contents of the item }
.gwt-DecoratedStackPanel .stackltemTopLeft { top left corner
of the item}
.gwt-DecoratedStackPanel .stackltemTopLeftinner { the inner
element of the cell}
.gwt-DecoratedStackPanel .stackltemTopCenter { top center
of the item}
.gwt-DecoratedStackPanel .stackltemTopCenterlnner { the
inner element of the cell}
.gwt-DecoratedStackPanel .stackltemTopRight { top right
corner of the item}
.gwt-DecoratedStackPanel .stackltemTopRightinner { the
inner element of the cell}
.gwt-DecoratedStackPanel .stackltemMiddleLeft { left side of
the item }
.gwt-DecoratedStackPanel .stackltemMiddleLeftinner { the
inner element of the cell}
.gwt-DecoratedStackPanel .stackltemMiddleCenter { center
of the item, where the item text resides }
.gwt-DecoratedStackPanel .stackltemMiddleCenterlnner { the
inner element of the cell}
.gwt-DecoratedStackPanel .stackltemMiddleRight { right side
of the item }
.gwt-DecoratedStackPanel .stackltemMiddleRightinner { the
inner element of the cell}
DecoratedTabBar A TabBar that wraps each tab in a 2x3 grid (six box), which Not included in the

allows users to add rounded corners.

.gwt-DecoratedTabBar { the tab bar itself }
.gwt-DecoratedTabBar .gwt-TabBarFirst { the left edge of the
bar }

.gwt-DecoratedTabBar .gwt-TabBarRest { the right edge of
the bar }

.gwt-DecoratedTabBar .gwt-TabBarltem { unselected tabs }
.gwt-DecoratedTabBar .gwt-TabBarltem-wrapper { table cell
around tab }

.gwt-DecoratedTabBar .gwt-TabBarltem-selected { additional
style for selected tabs }

.gwt-DecoratedTabBar .gwt-TabBarltem-wrapper-selected {
table cell around selected tab }

.gwt-DecoratedTabBar .tabTopLeft { top left corner of the tab}
.gwt-DecoratedTabBar .tabTopLeftinner { the inner element
of the cell}

.gwt-DecoratedTabBar .tabTopCenter { top center of the tab}
.gwt-DecoratedTabBar .tabTopCenterlnner { the inner

GWT Widget list.
Used by its TabPanel.
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Type

Description / CSS

Comment

element of the cell}

.gwt-DecoratedTabBar .tabTopRight { top right corner of the
tab}

.gwt-DecoratedTabBar .tabTopRightinner { the inner element
of the cell}

.gwt-DecoratedTabBar .tabMiddleLeft { left side of the tab }
.gwt-DecoratedTabBar .tabMiddleLeftinner { the inner
element of the cell}

.gwt-DecoratedTabBar .tabMiddleCenter { center of the tab,
where the tab text or widget resides }

.gwt-DecoratedTabBar .tabMiddleCenterlnner { the inner
element of the cell}

.gwt-DecoratedTabBar .tabMiddleRight { right side of the tab

}
.gwt-DecoratedTabBar .tabMiddleRightinner { the inner
element of the cell}
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Type

Description / CSS

Comment

DecoratedTabPanel

A TabPanel that uses a DecoratedTabBar with rounded
corners.

.gwt-DecoratedTabPanel { the tab panel itself }
.gwt-TabPanelBottom { the bottom section of the tab panel
(the deck containing the widget) }

DecoratorPanel

A SimplePanel that wraps its contents in stylized boxes,
which can be used to add rounded corners to a Widget.

.gwt-DecoratorPanel { the panel }

.gwt-DecoratorPanel .top { the top row }
.gwt-DecoratorPanel .topLeft { the top left cell }
.gwt-DecoratorPanel .topLeftinner { the inner element of the
cell }

.gwt-DecoratorPanel .topCenter { the top center cell }
.gwt-DecoratorPanel .topCenterlnner { the inner element of
the cell }

.gwt-DecoratorPanel .topRight { the top right cell }
.gwt-DecoratorPanel .topRightinner { the inner element of the
cell }

.gwt-DecoratorPanel .middle { the middle row }
.gwt-DecoratorPanel .middleLeft { the middle left cell }
.gwt-DecoratorPanel .middleLeftInner { the inner element of
the cell }

.gwt-DecoratorPanel .middleCenter { the middle center cell }
.gwt-DecoratorPanel .middleCenterlnner { the inner element
of the cell }

.gwt-DecoratorPanel .middleRight { the middle right cell }
.gwt-DecoratorPanel .middleRightinner { the inner element of
the cell }

.gwt-DecoratorPanel .bottom { the bottom row }
.gwt-DecoratorPanel .bottomLeft { the bottom left cell }
.gwt-DecoratorPanel .bottomLeftinner { the inner element of
the cell }

.gwt-DecoratorPanel .bottomCenter { the bottom center cell }
.gwt-DecoratorPanel .bottomCenterlnner { the inner element
of the cell }

.gwt-DecoratorPanel .bottomRight { the bottom right cell }
.gwt-DecoratorPanel .bottomRightinner { the inner element of
the cell }

DialogBox

A form of popup that has a caption area at the top and can be
dragged by the user.

.gwt-DialogBox { the outside of the dialog }

.gwt-DialogBox .Caption { the caption }

.gwt-DialogBox .dialogContent { the wrapper around the
content }

.gwt-DialogBox .dialogTopLeft { the top left cell }
.gwt-DialogBox .dialogTopLeftinner { the inner element of the
cell }

.gwt-DialogBox .dialogTopCenter { the top center cell, where
the caption is located }

.gwt-DialogBox .dialogTopCenterlnner { the inner element of

Via View Menu
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Type

Description / CSS

Comment

the cell }

.gwt-DialogBox .dialogTopRight { the top right cell }
.gwt-DialogBox .dialogTopRightInner { the inner element of
the cell }

.gwt-DialogBox .dialogMiddleLeft { the middle left cell }
.gwt-DialogBox .dialogMiddleLeftInner { the inner element of
the cell }

.gwt-DialogBox .dialogMiddleCenter { the middle center cell,
where the content is located }

.gwt-DialogBox .dialogMiddleCenterlnner { the inner element
of the cell }

.gwt-DialogBox .dialogMiddleRight { the middle right cell }
.gwt-DialogBox .dialogMiddleRightInner { the inner element of
the cell }

.gwt-DialogBox .dialogBottomLeft { the bottom left cell }
.gwt-DialogBox .dialogBottomLeftinner { the inner element of
the cell }

.gwt-DialogBox .dialogBottomCenter { the bottom center cell }
.gwt-DialogBox .dialogBottomCenterlnner { the inner element
of the cell }

.gwt-DialogBox .dialogBottomRight { the bottom right cell }
.gwt-DialogBox .dialogBottomRightinner { the inner element
of the cell }
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Type

Description / CSS

Comment

DisclosurePanel

A widget that consists of a header and a content panel that
discloses the content when a user clicks on the header.

.gwt-DisclosurePanel { the panel's primary style }
.gwt-DisclosurePanel-open { dependent style set when panel
is open }

.gwt-DisclosurePanel-closed { dependent style set when
panel is closed }

The header and content sections can be easily selected
using css with a child selector:
.gwt-DisclosurePanel-open .header { ... }

DockPanel

A panel that lays its child widgets out "docked" at its outer
edges, and allows its last widget to take up the remaining
space in its center.

CSS — no default

FileUpload

A widget that wraps the HTML <input type="file'> element.
This widget must be used with FormPanel if it is to be
submitted to a server.

.gwt-FileUpload{}

FlexRow

A custom widget to group a row of FlexTable widgets.

CSS — not applicable

A structural widget
used only in the Ul
Tree to simplify
building a FlexTable.

FlexTable

A flexible table that creates cells on demand. It can be jagged
(that is, each row can contain a different number of cells) and
individual cells can be set to span multiple rows or columns.

CSS — no default

FlowPanel

A panel that formats its child widgets using the default HTML
layout behavior.

FocusPanel

A simple panel that makes its contents focusable, and adds
the ability to catch mouse and keyboard events.

CSS — no default

FormPanel

A panel that wraps its contents in an HTML <FORM>
element.

The following widgets (those that implement HasName) will
be submitted

to the server if they are contained within this panel:

* TextBox

* PasswordTextBox
* RadioButton

* SimpleRadioButton
* CheckBox

* SimpleCheckBox

* TextArea

* ListBox

* FileUpload

* Hidden
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Type

Description / CSS

Comment

CSS — no default
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Type Description / CSS Comment
Frame A widget that wraps an IFRAME element, [WARN] Confirmation
which can contain an arbitrary web site. was required to visit
If you are using History, any browser history untrusted URL:
items generated by the Frame will interleave 'http://www.google.co
with your application's history. m/
[WARN] reason:
.gwt-Frame { } http://www.google.com
/is not in the whitelist
[WARN] To fix: add
regex matching URL to
-whitelist command
line argument
[WARN] Example: -
whitelist="
Mhttp[:][/[/Jwww(.]googl!
e[.Jcom"”
[WARN] To reject
automatically: add
regex matching URL to
-blacklist command
line argument
[WARN] Example: -
blacklist="
Mhttp[:]1/][/]www[.]googl!
e[.Jcom"
Grid A rectangular grid that can contain text, html, or a child
Widget within its cells. It must be resized explicitly to the
desired number of rows and columns.
CSS - no default
Hidden Represents a hidden field in an HTML form.

CSS — not applicable

HorizontalPanel

A panel that lays all of its widgets out in a single horizontal
column.

CSS — no default

HorizontalSplitPanel

A panel that arranges two widgets in a single horizontal row
and allows the user to interactively change the proportion of
the width dedicated to each of the two widgets. Widgets
contained within a HorizontalSplitPanel will be automatically
decorated with scrollbars when necessary.

.gwt-HorizontalSplitPanel { the panel itself }
.gwt-HorizontalSplitPanel hsplitter { the splitter }

HTML A widget that can contain arbitrary HTML. This widget uses a
<div> element, causing it to be displayed with block layout.
gwt-HTML {}
HTMLPanel A panel that contains HTML, and which can attach child Future

widgets to identified elements within that HTML.

CSS — no default
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Type Description / CSS Comment
Hyperlink A widget that serves as an "internal" hyperlink. That is, itisa | Future
link to another state of the running application. When clicked,
it will create a new history frame using History.newltem
(java.lang.String), but without reloading the page.
.gwt-Hyperlink {}
Image A widget that displays the image at a given URL. The image
can be in 'unclipped' mode (the default) or 'clipped’ mode.
.gwt-lmage { }
InlineHTML A widget that can contain arbitrary HTML. This widget uses a
<span> element, causing it to be displayed with inline layout.
.gwt-InlineHTML { }
InlineLabel A widget that contains arbitrary text not interpreted as HTML.
This widget uses a <span> element, causing it to be
displayed with inline layout.
.gwt-InlineLabel { }
Label A widget that contains arbitrary text not interpreted as HTML.
This widget uses a <div> element, causing it to be displayed
with block layout.
.gwt-Label { }
ListBox A widget that presents a list of choices to the user, either as a | Defaults to multiple
list box or as a drop-down list. select because the
setMultipleSelect
.gwt-ListBox { } method is deprecated
in GWT 1.6. For
single select modify
the constructor in the
generated Java code.
To add multiple items
enter them in the
Addltem property
delimited by comma
MenuBar A standard horizontal menu bar widget. A menu bar can

contain any number of menu items, each of which can either
fire a Command or open a cascaded menu bar.

.gwt-MenuBar

the menu bar itself

.gwt-MenuBar-horizontal

dependent style applied to horizontal menu bars
.gwt-MenuBar-vertical

dependent style applied to vertical menu bars
.gwt-MenuBar .gwt-Menultem

menu items

.gwt-MenuBar .gwt-Menultem-selected

selected menu items

.gwt-MenuBar .gwt-MenultemSeparator

section breaks between menu items
.gwt-MenuBar .gwt-MenultemSeparator .menuSeparatorinner
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Type

Description / CSS

Comment

inner component of section separators
.gwt-MenuBarPopup .menuPopupTopLeft
the top left cell
.gwt-MenuBarPopup .menuPopupTopLeftinner
the inner element of the cell
.gwt-MenuBarPopup .menuPopupTopCenter
the top center cell
.gwt-MenuBarPopup .menuPopupTopCenterlnner
the inner element of the cell
.gwt-MenuBarPopup .menuPopupTopRight
the top right cell
.gwt-MenuBarPopup .menuPopupTopRightinner
the inner element of the cell
.gwt-MenuBarPopup .menuPopupMiddleLeft
the middle left cell
.gwt-MenuBarPopup .menuPopupMiddleLeftinner
the inner element of the cell
.gwt-MenuBarPopup .menuPopupMiddleCenter
the middle center cell
.gwt-MenuBarPopup .menuPopupMiddleCenterlnner
the inner element of the cell
.gwt-MenuBarPopup .menuPopupMiddleRight
the middle right cell
.gwt-MenuBarPopup .menuPopupMiddleRightinner
the inner element of the cell
.gwt-MenuBarPopup .menuPopupBottomLeft
the bottom left cell
.gwt-MenuBarPopup .menuPopupBottomLeftinner
the inner element of the cell
.gwt-MenuBarPopup .menuPopupBottomCenter
the bottom center cell
.gwt-MenuBarPopup .menuPopupBottomCenterlnner
the inner element of the cell
.gwt-MenuBarPopup .menuPopupBottomRight
the bottom right cell
.gwt-MenuBarPopup .menuPopupBottomRightinner
the inner element of the cell
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Type Description / CSS Comment
MenuBarV A standard vertical menu bar widget. A menu bar can contain | Same as MenuBar but
any number of menu items, each of which can either fire a Vertical.
Command or open a cascaded menu bar. Required because
GWT does not have a
CSS - see MenuBar property to change
MenuBar orientation
(must be specified in
the constructor)
Menultem A widget that can be placed in a MenuBar

CSS - see MenuBar

MenultemSeparator

A separator that can be placed in a MenuBar.

CSS - see MenuBar

Panel

Abstract base class for all panels, which are widgets that can
contain other widgets.

Not included in the
GWT Widget list.

PasswordTextBox

A text box that visually masks its input to prevent
eavesdropping.

.gwt-PasswordTextBox { primary style }
.gwt-PasswordTextBox-readonly { dependent style set when
the password text box is read-only }

PopupPanel

A panel that can "pop up" over other widgets. It overlays the
browser's client area (and any previously created popups).

A PopupPanel should not generally be added to other panels;
rather, it should be shown and hidden using the show () and
hide () methods.

.gwt-PopupPanel
the outside of the popup
.gwt-PopupPanel .popupContent
the wrapper around the content

Via View Menu

PushButton

A normal push button with custom styling.

.gwt-PushButton-up/down/up-hovering/down-hovering/up-
disabled/down-disabled {.htmlI-face}

RadioButton

A mutually exclusive selection radio button widget.

.gwt-RadioButton { }

RichTextArea

A rich text editor that allows complex styling and formatting.

.gwt-RichTextArea { }

For examples:

See the GWT
Showcase, or

GWT Applications by
Ryan Dewsbury

RootPanel

The panel to which all other widgets must ultimately be
added. RootPanels are never created directly. Rather, they
are accessed via get ().

Not included in the
GWT Widget list.

ScrollPanel

A simple panel that wraps its contents in a scrollable area.

CSS — no default

SimpleCheckBox

A simple checkbox widget, with no label.
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Type

Description / CSS

Comment

.gwt-SimpleCheckBox { }
.gwt-SimpleCheckBox-disabled { Applied when checkbox is
disabled }
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Type

Description / CSS

Comment

SimplePanel

Base class for panels that contain only one widget.

CSS — no default

StackPanel

A panel that stacks its children vertically, displaying only one
at a time, with a header for each child which the user can
click to display.

.gwt-StackPanel { the panel itself }

.gwt-StackPanel .gwt-StackPanelltem { unselected items }
.gwt-StackPanel .gwt-StackPanelltem-selected { selected
items }

.gwt-StackPanel .gwt-StackPanelContent { the wrapper
around the contents of the item }

SuggestBox

A SuggestBox is a text box or text area, which displays a pre-
configured set of selections that match the user's input.

.gwt-SuggestBox
the suggest box itself

.gwt-SuggestBoxPopup
the suggestion popup

.gwt-SuggestBoxPopup .item
an unselected suggestion

.gwt-SuggestBoxPopup .item-selected
a selected suggestion

.gwt-SuggestBoxPopup .suggestPopupTopLeft
the top left cell

.gwt-SuggestBoxPopup .suggestPopupTopLeftinner
the inner element of the cell

.gwt-SuggestBoxPopup .suggestPopupTopCenter
the top center cell

.gwt-SuggestBoxPopup .suggestPopupTopCenterinner
the inner element of the cell

.gwt-SuggestBoxPopup .suggestPopupTopRight
the top right cell

.gwt-SuggestBoxPopup .suggestPopupTopRightinner
the inner element of the cell

.gwt-SuggestBoxPopup .suggestPopupMiddieLeft
the middle left cell

.gwt-SuggestBoxPopup .suggestPopupMiddleLeftinner
the inner element of the cell

.gwt-SuggestBoxPopup .suggestPopupMiddleCenter
the middle center cell

.gwt-SuggestBoxPopup .suggestPopupMiddleCenterlnner
the inner element of the cell

.gwt-SuggestBoxPopup .suggestPopupMiddieRight
the middle right cell

.gwt-SuggestBoxPopup .suggestPopupMiddieRightinner
the inner element of the cell

.gwt-SuggestBoxPopup .suggestPopupBottomLeft
the bottom left cell

.gwt-SuggestBoxPopup .suggestPopupBottomLeftinner
the inner element of the cell

.gwt-SuggestBoxPopup .suggestPopupBottomCenter
the bottom center cell
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Type

Description / CSS

Comment

.gwt-SuggestBoxPopup .suggestPopupBottomCenterlnner
the inner element of the cell

.gwt-SuggestBoxPopup .suggestPopupBottomRight
the bottom right cell

.gwt-SuggestBoxPopup .suggestPopupBottomRightlinner
the inner element of the cell
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Description / CSS

Comment

TabBar

A horizontal bar of folder-style tabs most commonly used as
part of a TabPanel.

.gwt-TabBar { the tab bar itself }
.gwt-TabBar .gwt-TabBarFirst { the left edge of the bar }

.gwt-TabBar .gwt-TabBarFirst-wrapper { table cell around the

left edge }
.gwt-TabBar .gwt-TabBarRest { the right edge of the bar }

.gwt-TabBar .gwt-TabBarRest-wrapper { table cell around the

right edge }
.gwt-TabBar .gwt-TabBarltem { unselected tabs }

.gwt-TabBar .gwt-TabBarltem-wrapper { table cell around tab

}
.gwt-TabBar .gwt-TabBarltem-selected { additional style for
selected

Not included in the
GWT Widget list.
Used by the TabPanel

TabPanel

A panel that represents a tabbed set of pages, each of which
contains another widget.

.gwt-TabPanel { the tab panel itself }
.gwt-TabPanelBottom { the bottom section of the tab panel
(the deck containing the widget) }

Add a TabPanel inside
another panel that has
width set, then set
TabPanel width.

TextArea

A text box that allows multiple lines of text.

.gwt-TextArea { primary style }
.gwt-TextArea-readonly { dependent style set when the text
area is read-only }

TextBox

A standard single-line text box.

.gwt-TextBox { primary style }
.gwt-TextBox-readonly { dependent style set when the text
box is read-only }

ToggleButton

A ToggleButton is a stylish stateful button, which allows the
user to toggle between up and down states.

.gwt-ToggleButton-up/down/up-hovering/down-hovering/up-
disabled/down-disabled {.htmlI-face}

Tree

A standard hierarchical tree widget. The tree contains a
hierarchy of Treeltems that the user can open, close, and
select.

.gwt-Tree
the tree itself

.gwt-Tree .gwt-Treeltem
a tree item

.gwt-Tree .gwt-Treeltem-selected
a selected tree item

Treeltem

An item that can be contained within a Tree.

CSS —see Tree

VerticalPanel

A panel that lays all of its widgets out in a single vertical
column.

CSS — no default

VerticalSplitPanel

A panel that arranges two widgets in a single vertical column
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Type

Description / CSS

Comment

and allows the user to interactively change the proportion of
the height dedicated to each of the two widgets. Widgets
contained within a VerticalSplitterPanel will be automatically
decorated with scrollbars when necessary.

.gwt-VerticalSplitPanel { the panel itself }
.gwt-VerticalSplitPanel vsplitter { the splitter }
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GWTWidget Properties

The Properties supported by the GWT Widgets are listed below.
Where possible the Property name corresponds to the GWT Property.

GWTWidget Property Description Sample
All GWT_Type Read only. The type of VerticalPanel
widget
Id The element’s identifier myunique
Width The object’s width in CSS 100%
units
Height The object’s height in CSS 200px
units
Title The tool-tip Some info
Visible Is the object visible true / false
StyleName_ADD Add a secondary style mystyle
StyleName_SET Clear all styles and set to gwt-Button

the given style

StyleDependentName A suffix added to the gwt-TabBarltem-selected
primary style
StylePrimaryName The object’s primary style gwt-TabBarltem
StackText Stack heading when a My Heading
widget is a child of
StackPanel or
DecoratedStackPanel
TabText Tab heading when a widget | My Tab
is a child of TabPanel or
DecoratedTabPanel
ColumnHeading The Column Heading when | MyButtonHdg
used in a Grid
AbsolutePanel no extra
Anchor Direction a direction that is right-to-left | LTR
(RTL), left-to-right (LTR)
Name the name that will be myname
associated with the widget
when its form is submitted
Focus can receive keyboard focus | true
Horizontal Alignment indicates that a widget can ALIGN_CENTER
be aligned horizontally
HTML the object's text can be set <H1>Header</H1>
either as HTML or as text
Text an object contains text Hello
WordWrap indicates word-wrapping is true
enabled
Href the anchor's href (the url to http://www.google.ca/
which it links)
Target the frame in which _blank
navigation will occur when
the link is selected
Button Focus
HTML
Text
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GWTWidget Property Description Sample
CaptionPanel CaptionText the Text caption for the
panel
CheckBox Focus
HTML
Name
Text
Checked the CheckBox state true
Enabled whether this widget is true
enabled
DateBox no extra
DecoratedStackPanel no extra
DecoratedTabPanel no extra
DecoratorPanel no extra
DisclosurePanel HeaderText the Text header for the My Header

panel

DockPanel HorizontalAlignment indicates that a widget can ALIGN_CENTER
be aligned horizontally
VerticalAlignment indicates that a widget can ALIGN_MIDDLE
be aligned vertically
DockAlign_XXXX Read only. Contains the myLabWidgetName
LabWidget name at the
location. Set when add a
LabWidget to the DockPanel
FileUpload no extra
FlexRow no extra Not a GWT widget. Used for
structure only.
FlexTable BorderWidth the width of the table's 1 (for 1px)
border, in pixels
CellPadding the amount of padding to be | 5 (for 5px)
added around all cells, in
pixels
CellSpacing the amount of spacing to be | 2 (for 2px)
added around all cells, in
pixels
FlowPanel no extra
FocusPanel no extra
FormPanel no extra
Frame Url the URL of the frame's http://www.google.ca/
resource
Grid BorderWidth
CellPadding
CellSpacing
ColumnCount the number of columns in 8
this grid
RowCount the number of rows in this 10
grid
Hidden DefaultValue the default value of the mydefaultvalue
hidden field
Id the id of the hidden field uniqueid
Value the value of the hidden field | myvalue
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GWTWidget Property Description Sample
HorizontalPanel HorizontalAlignment
VerticalAlignment
HorizontalSplitPanel HorizontalSplit_LEFT Read only. The LabWidget myNavPanel
in the left side of the panel.
Set when add a LabWidget
to the Panel
HorizontalSplit_RIGHT Read only. The LabWidget myContentPanel

in the right side of the panel.
Set when add a LabWidget
to the Panel

HTML

Direction

HorizontalAlignment

HTML

Text

WordWrap

Image

Url

InlineHTML

Direction

HorizontalAlignment

HTML

Text

WordWrap

InlineLabel

Direction

HorizontalAlignment

Text

WordWrap

Label

Direction

HorizontalAlignment

Text

WordWrap

ListBox

Focus

Name

Addltem

The item name(s) to be
added to the ListBox.
Delimited by comma

apple, orange, pear

Selectindex

the currently selected index

0 (selects the first item)

VisibleltemCount

the number of items that are
visible. setting this value to
1 turns it

into a drop-down list

3

MenuBar

AutoOpen

indicates whether this menu
bar's child menus will open
when the mouse is moved
over it

true

AnimationEnabled

indicates whether
animations are Enabled

false

MenuBarV

same as MenuBar

Menultem

HTML

Text

MenultemSeparator

no extra

PasswordTextBox

Direction

Focus

Name

Text
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GWTWidget

Property

Description

Sample

MaxLength

VisibleLength

PushButton

Focus

HTML

Text

RadioButton

Focus

HTML

Name

Text

Checked

Enabled

RichTextArea

Focus

HTML

Text

ScrollPanel

no extra

SimpleCheckBox

Focus

Name

Checked

Enabled

SimplePanel

no extra

StackPanel

no extra

SuggestBox

Focus

Text

Suggestion

The suggestion(s) to be
added to the SuggestBox.
Delimited by comma

car, cat, career, coat

TabPanel

no extra

TextArea

Focus

Name

Text

TextBox

Direction

Focus

Name

Text

MaxLength

the maximum allowable
length of the text box

50

VisibleLength

the number of visible
characters in the text box

30

ToggleButton

Focus

HTML

Text

Tree

Focus

Treeltem

HTML

Text

VerticalPanel

HorizontalAlignment

VerticalAlignment

VerticalSplitPanel

VerticalSplit_TOP

Read only. The LabWidget
in the top of the panel

myTopPanel

VerticalSplit. BOTTOM

Read only. The LabWidget
in the bottom of the panel

myBottomPanel
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